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HIGHLIGHTS OF NEW FEATURES
1.	New Capture Desktop - Experiment Mode	4
2.	New Capture Desk Top - Recipe Mode	5
3. Export of Raw Data	6
4. .	ESCA Control Panel -Replacement for A Quick	8
5. Motor Control Panel - GPIB Interface	9
6. Motor Control Panel -Ethernet Interface	10
7. Position Table	11
TOPICAL DESCRIPTION OF SOFTWARE
Inthe following sections, topics of operation are discussed in alphabetical order
(	1.	Calibration and Setup
a. Introduction to applet	13
b.   Outline of steps	14
c. Hardware configuration	14
d.  Software configuration	15
e.  Establishing starting calibration values	17
f.	Run DAC to calibrate BE span	19
g.  Run Detector Width Calibration	20
h.  Run Vl curves	21
i.	Signature correction	22
2. Database Functions	25
a. Creating a new database	26
b.  Get recipes from another database	27
3. Depth Profiles	29
a. Open the depth profile table generator	29
4. .	ESCA Control Panel 	31
a. Unscanned mode	31
b.  Scanned Mode	32
c.	Quick survey	33
(





5. Experiment Names as part of the database structure.
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(
6. Graphics controls
a. Chart editor	36
b. .   User Preferences	38
c. Print Utility	39
d. Spectrum color	41
e. Clipboard	41
7. Motion Control
a. Angle Resolve and tilt stage setup	42
b. Enable/Disable Buttons	47
c. Home controls	47
d. Mode control of the Joystick buttons (6K4)	48
e. Panic Button	50
f.	Position Table Setup	51
g.   Rotation	54
h.  System Configuration (GPIB, 6K4, disable axes)	55
1.	Units, coordinates	56
J.	Velocity Setup (GPIB with 2100 Indexers)	57
8. MRS Tables	58
(	a.   Construction by selecting and editing Functions	59
b. Templates	62
c. Run Controls	63



Software conventions

1.	When text boxes are White they will accept data entry. 2 .	When text boxes are Blue they are read only.
3.	Buttons or labels that are Red indicate something is turned off. 4.	Buttons that are Green indicate something is turned on.
5.	Buttons that are Yellow indicate something is tmned on but temporarily not in a useable state.
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New  Capture Desktop - Experiment Mode
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A Quick is no longer available.  There is no requirement to create a recipe . When in Experiment Mode, simply edit the MRS table to create a parameter set for the next data acquisition . The MRS table will be stored with the data.

The Experiment Tree shows the past experiments.  Selecting an experiment will recall the stored MRS table. You have four options :

1.  Run MRS table with a new Project/Experiment name.
2. .  Modify MRS table and run with new Project/Experiment name.
3. Ove1write recalled Experiment .
4. .  Save MRS table as a Recipe. To save MRS as a recipe use File menu, Save As -Recipe.

The Clear button provides a quick way to start a new MRS table . Don't wony about the existing MRS table.  If it has been run it is saved. All MRS tables saved with experiments have the Recipe name "None".
(
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(	New Capture Desk Top - Recipe Mode
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(1 Prtnl:Recipe
1. 
Save Recipe. Requires Recipe Mode.	Saves current state of MRS table to active recipe.  Save Icon causes same action.

2. Save As - Recipe creates a new Category/Recipe. May be used from Experiment Mode.





D:\ESCA 2000 G\boo.rodb
D:\ESC1\ 2000 G\exarnples.m<lb D:\ESCA 2000 G\bob.rndb D:\ESCA 2000 G\exam1:fos.mdb
3. 
In Recipe Mode changes to MRS are NOT saved unless the Save Recipe or Save Icon is used.  Recipes should not be changed after they are established . This can cause unexpected results in linked Position Tab
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To create a new recipe just Clear the current MRS table and then compose a new table . Then to turn the MRS table into a Recipe :

I .	Go to File menu and select Save AS - Recipe
2. .	File out the Category name, Recipe name and description.
3. You can browse to an existing Category and then edit the Recipe. This provides a fast way to add Recipes in a sequence.
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Export of Raw Data
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1. Select an Experiment.  Ifonly some regions are to be exported mark them visible.	(
2. Select Export in the File menu .

·iii.Review Source Information - EXPORTER	l!llil f3
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3. Choose All regions or Only Visible regions.   Select type of export.

(
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(	Export of Raw Data - Cont.
The VAMAS export is an ASCII file readable by any text editor.  The anangement of information follows the international standard for Surface Science Data.  All region of the MRS can be included in one VAMAS file. The VAMAS file can hold a complete depth profile . This is a very flexible and well-defined expmi file.

To use the Excel export, Excel must be available on the computer running the ESCA application . It does not need to be rnnning. The expmi will open an Excel notebook, fill header cells with instrument parameters and provide a column of numbers representing the spectrum data. A crude graph is also created for quick review. There will be one page per spectrum. All spectra for a MRS table or just the regions marked visible can be included. A depth profile can be expmied.

Fakedata.txt is an internal text file used for demonstration pmposes.  Any spectra can be conve1ied to a fakedata.txt file and then used by the Demo program to simulate the collection of data. This can be convenient for training and remote investigation of the program operation.

 (
11113
)E><port File Dialog
Save in: IdE SCt.. 2000 G .

(	_J CD Install Esca 2000 A
.'::J CD Install Esc.:i 2000 B
.::J CD Install Esca 2000 E
::JCD Install Esca 2000 G
:=J Gproject
:JKoazk
...J Maps
:'.JMDB set
.:J MdbScanner

C::J nev·.' xpc
CJ f'.Jo Motors P.:irts
D MOTES
CJ Pack E
LJPack G
Dv2.1 rndb l/ie1Ner
hires only. vrns
 (
L
.:..11
)rITTil onlv one .vrns


 (
1
). surve·:.1 and hires. vms survey for test .vrns






File naroe:	surve  for test vm Save as type:	!v.:imas: format(". vms)

Save Cancel




The Export File Dialog is used with the VAMAS export.  This is a standard Windows dialog.  File storage for the Excel is handled out of the Excel program.
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(
ESCA Control Panel -Replacement for A Quick
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The ESCA control panel is used for direct access to the spech·ometer.
You may change a setup condition and hit start even if a scan is in progress . The scan will automatically abort and resta1t. The Time/Step can be changed. If scanned is checked "Capture T" provides an estimate of the total capture time. The top row of controls will change the state of the ESCA when the control is clicked. The eight controls in the frame change state when the Stait button or Enter Key is hit.
(
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(
Motor Control Panel - GPIB Interface

View Menu item, Motion Control Pn1
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1. Configure Motors:
a. Set type of motion control interface
b. Turn on/off individual axes.
2. Velocity Setup:
(	a.    Set velocity of individual axes.
3. Home Controls
a. Set XYZ:   Set current XYZ position 0,0,0 b.   Set R:  Set cmTent R position 0
c. GOTO XYZ: Return to XYZ = 0,0,0
d. GOTO R: Return to R = 0 or 360
4. Rotation
a. Cont.	Staits continuous rotation . b.   Stop	Stops continuous rotation .
5.	Panic	Stops all motion and disables Motors.
6.		Motors:	Green means Enabled. Yellow means computer control. Red means Disabled.
7. Units:
a. XYZ : Set scale system to MM, Inches or number of steps.
b. Rotation : Set scale system to Deg, number of steps or tilt.
c. GOTO or Get *	IF number is present in any white box then motors
will move to position.   If all boxes empty then computer will get cunent position.  This is useful after Joystick movement of stage.  * denotes that
the Enter Key will produce this function if form is active.
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(
Motor Control Panel -Ethernet Interface
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The Ethernet interface and 6K4 controller allow for use of a USB Joystick.  The Joystick button has three states:

Green - Enabled
Yellow - Motion under computer control
Red - Disabled.  This secures the motion system from accidental input while running a position table .
(
The button labeled "Joystick Buttons" controls the state of the remote buttons located of the joystick. Two buttons can be set to update the home positions or to cause f01ward or back stepping through the position table. The state is toggled between these two
functions by this button. The message box inred with yellow letters desc1ibes the cmTent state.

It will be noticed that one additional difference between the GPIB/2100 Indexer system and the Ethernet/6K4 system is the speed of operation . The Ethernet communication provides real time position information during the motion of the stage. The blue read only boxes post the position in real time.



Page 51 for Position Table Setup








(


10







(	Position Table
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Steps to set up Position Table :

1. Tool Bar > View > Motion Control Pnl
2. MRS Table function  > PT M > Table Name (Default in this case) > Design Button .
3. Table options:
a. Create a new table, Clear the displayed table, Delete the displayed table or Save and run table.
b. Create a table of positions:
I. Learn positions using joystick.
11.     Move to positions using control panel, then transfer to table .
111.    Numerical entry directly to table .
c. Table Row controls
I. Add row
IL    Delete row ni.  Move row up
iv.  Move row down
(
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4. Review of positions .	(
a. Select "numbered" buttons at end of Row. Stage will move to position.
b. Select Step forward/Step Back buttons on Table Form.
c. Select Step fo1ward/Step Back buttons on USB joystick (6K4 controller).

5. Assign recipes
a. Select Recipe mode.  Click drop down box for each row. Assign Recipe from list.

It is very important to step through all positions before running a table. We have noticed that the positions will not be the same on the first pass after learning. However, as the positions are reviewed buy stepping through them in order, it is easy to refine the stored coordinates by using the joystick learn button. The row cursor automatically follows.
This usually stabilizes the learned positions .

As the positions are reviewed, be sure limit conditions are not displayed. During the running of a position table a limit condition will keep the stage fonn moving to the coITect position. You will be notified if this occurs.

To run the position table:

1.	"Save and Exit" the position table
2.	Enter the Project, Experiment and Experiment description  information.
3. Select the Run (from top) button	(

During the collection of data the MRS table will display the individual MRS tables for each position.  The Experiment Name window will display:

Your Experiment Name:POS X  where X is the position number.

For more details on Position tables See "Position Table Setup" pg 51
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(
Calibration and Setup - Outline of steps

It is very helpful if the calibration parameter values, from the previous software, are available. IF you are upgrading from ESCAVB without a change of operating system these steps are not required.  If a new operating system was installed then proceed with calibration.

1. Configure the registry entries for the ESCA system hardware .
2. .	Configure calibration parameter values that were used i11 previous software.  If
these are not available then develop a rough set of starting values .
3. Run DAC to calibrate the span of the BE scale.
4. .	Run Detector Width to calibrate the detector and set the absolute BE.
5. If the ESCA Instrument has a Vl (lens focus voltage) supply in the Spectrometer Power Supply that is digitally controlled then nm Vl calibration cmves.
6. Return to the main program and set up Signature cmrection .

Calibration  and Setup -Hardware configuration

Use the main tool bar and select the Settings men u.  Select Capture Settings.
(
 (
Capture
 
2,ettings
)jl_E.e _ :n:w [ Settings tielp  E it
:I D P--1"'	Set S)istem Registry Defaults
JJ	L-1   ...


r Recipe
r. E:-:perime

on
Edit Scofield Table Set up ESCA
Create a new Signature file

;.;-; Default ----------
@') Temp
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(
Calibration and Setup -Hardware configuration - Detector


Select the Detector Tab in the Dialog.  Ifa valid signature file is available then check the Signature Correction ON box.  Ifthis is a new installation then see Signature Conection section below .

Ifthe "Signature file could not be loaded" message was displayed during the staitup of the program check the Signature File Path.  The sig.txt file, that holds a valid signature, must be available . The installation will make a dummy sig.txt file that makes no signature correction.  It is loaded inthe ESCA 2000 folder.  To use this default file make sure the path points to the ESCA 2000 folder.  Ifyou set up a custom folder then  enter the custom path statement in the Signature file Path window.

The Dither box should be checked if a 2502 fast detector and 2503 buffer memory are used.  Ifa 2401 Position computer is used do not check the Dither box.

Horizontal Linerization is not available in this release.
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(
Calibration and Setup -Hardware configuration -X-Rays

Standard settings for a Monochromator  system.

A	Somce Type:	Al
B.	Filter:	Monochromator
C. Reference Energy:	1486.6 is provided as the accepted value D:	Please select the type of X-Ray gun controller

Note :  "Other" is used for X-Ray guns that are not controlled from this software.  The VG 8730 can be controlled using the 8702 LI S .




iii. Capture settings.	 	


Detector	X-Rays	Spectrorneter
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Non-Monochromator Systems

A	Select source Type from list
B.	Select None or Foil.





	









Update


None will establish a list of satellite peaks with full intensities as specified in the literature . Foil will allow adjustment of the satellite intensities. This is an empirical process . We assume the satellites are attenuated by the window foil. The Filter
(	Transmission Fraction is the Transmission for the satellite peak compared to the Primary
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peak.  The Transmission Fraction can be specified for the satellite nearest the Primary	(
peak and the satellite farthest from the Primary peak.  A linear variation in transmission is computed for the intermediate peaks .

The Filter Transmission Fractions are determined by collecting a spech11m and then using the Satellite subtract ftmction in the Tools menu found at the top of the spectrum display window.  Adjust the Filter Transmission Fraction for the Near Peak until the subtraction produces a smooth baseline in the region of the near satellite. Then adjust the Filter Transmission Fraction for the far peak.  You may need to iterate the setting a few times. Your final Transmission values will be saved with all spectra at the time of capture. The satellite subtraction can be performed in the Capture program or the Data Analysis program.

Refer to Satellite Subtraction in the Data Analysis section under Manipulating Spectra.
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)Calibration and Setup -Hardware configuration - Spectrometer








(

1. Select the type of spectrometer power supply from the drop down list.
2. Select the type of lens from the drop down list.

Ifthe Spectrometer Power Supply entry is changed then you must exit the Capture Application and re-start it so the instrument interface and be re-initialized . You will be reminded of this requirement when the Capture Setting Dialog is closed.


Updating the Registry

Ifyou Cancel the dialog or use the "X" button, none of the changes made during your session with the Capture Setting Dialog will be saved.  You must use the Update button to save your changes.  The dialog will close after the Updates are complete, so it is convenient to make all desired changes before Updating .
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Calibration and Setup - Calibration Parameters	(
To enter calibration parameters into the registry open the Set up ESCA applet.


] Eile  Y.iew  t[elp j Settings  Eit

[] d t. :	1
 (
r.
)!Recipe
Experiment
,... Default
T emp


Set S;1stem Registry Defaults Capture  !:references
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Create a new Signature file
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Set Up ESCA Applet.




 (
Spectrometer
 
Control
 
Panel
 
 
 
Start
 
Accumulation   
 
I
 
C
enter
 
8
e
..
_
2
.
?
.
,
8
.
.,.
VV
i
ndo
wW
idt
 
h
20
Num
b
e
r
O
IPoi
n
t
s
·
1
29
N
s
c
a
n
s
 
I 
 
h
ea
d
s
1
R
e
s
olu
t
 
i
on
 
!
,
3
S
c
a
nn
e
d
w
Hor
i
zli
n
 
e
a
ri
zati
o
n
r
D
i
th
e
r
e
d
r
S
i
g
n
a
tu
re
r
.6.
c
qu
i
s
i
ti
o
n
0    
 
- 
 
-
J
 
Conligu
 
1
a
li
o
n
 
I
 
D
e
t
ec
torWidl
 
h
 
]
 
D.6
.
C
- 
 
..
 
-   
 
-   
 
-
 
- 
 
•.
0
'
I
V
l
C
ur
v
e
s
 
]
)[image: ](

Data







Play Mode
BindingEner gy	278
Resolution j 1	3
Yr
V1
Vr long
VI long
pass energy

r Collect Data FilterCoefllcienl

Read Once


0

Accessories
Xray jxR ayOOO ::J f;7 Operate
Aperture j None	::J
FloodGun	r
lonGun	r
Interlock	w
Accessorylvla sk OxO




18







(	Calibration and Setup -Calibration Parameters

The calibration parameters  are entered into the Configuration Table located on the Configuration Tab.
--,-	- ----
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After entering changes to the values you must select the Commit button to wite the changes to the registty .

Type 5000 for the MSResSettleTime.   This will shorten the wait time when the resolution is changed from 12 seconds to 5 seconds.

Ifyou have calibration values from the HP workstation (9800 series) then one adjustment to the calibration values is required. For each Resolution cmTect the pass energy. Use  the Detector With for the same Resolution as the Pass Energy .

New Pass energy = Old Pass energy + (Detector Width)/2

Ifyou are upgrading from the DOS Vectr·a software or have installed a new operating system then use the pass energy that was previously used.
(
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Calibration and Set up -Calibration Parameters cont.	(
Make the following entries to the Configuration table if data is available.


Entry . DetVVidthRes·l DetVVidthRes2 Det\NidthRes3 DetVVidthRes4 DetV\ idthRes5



7.282358326
15
21
1.45


t s Use Existing Detector	ts
..._'Nid_t_hs__f_a_v_a__ab__e_.	_.... t s
If detector coefficients
If detector  c oefficient s _.I

PassEvRes1 PassEvRes2

Enter Pass Energies as 59.32277305557   St	discussed above.

tin
tin

PassEvRes3

113.5646445856E St1'lh-.----	---n tin

PassEvRes4	·166.596·1 77142·1 [ String
PassEvRes5	·12.8	String

f\J ot used at present tin
Not used at present tin

SensitivityExp Res1 -	L-	str" •"-"'"-'-'----'--'--	.........._....,, ... pe
Sensitivit yExpRes2	Enter Sensitivity Exps	pe
Sensitivit yExpRes3	on yif special values	pe
Sensitivit yExpRes4	have been established.	pe

Sensitivit yExpR es5
\/1 OffsetRes1
\/1 OffsetR es2
\/1 OffsetR es3

0.700000

84.
142.721457


VJ offsets  and Slopes
for 8701B or 8724



H;! \
e \
e \

\/1 OffsetR es4
\/1 OffsetR es5
\/1 SlopeRes1
\/1 SlopeRes2
\/1 SlopeRes3
\/1 Sl.opeRes4

226.855499
100.000000
0.423228
0.442913
0.492126
0.545024

St	only. Note values for	e \
St	VI curve setup.	e \	(
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0.500000	Strin LL---'-'""-'-1.u.....LU.....C'-"'.LL.:..L.U..:oU.g_1he   \
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lt--- ------<i \f r

Xyzlv1otors0n Rtv1otor0n

0	--=::::::::::::---	u:u"'-""''--'---'---'----....,+     tin
0	Motor parameters,	tin

RCode

1·106

all 6, not used.
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Cal VD 8701
Cal-VD-300-8724
Cal-VD-1500-8724
Cal-VD-3000-8724

·1 107	ev1c
·1·108	DVVORD Determines  GPIB  devic
"11 09	DVvr DAC  for  8701	]vi e
40	W I	.  lta.
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163.9 -=::::::::::::::::;:;;;:;;	Ita!
80.000000

Cal Vl 8701
Cal V..1 87Cl"l

40 .000000
40 .000000
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Used to translat e volta!
Used to translat e volta!
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(
Calibration  and Set up -Establishing starting calibration values

Ifthe above calibration values are not available then follow these steps:

1. Set DetWidthRes4 to 19 eV and the PassEVRes4 to 166 eV.  Make these entries in the configuration table and use the Commit button to register these values . Leave all other values as shipped .
2. .  Set up a gold sample and be sure all supplies are on. Set the X Probe Spectrometer Setup control panel as shown below and Start Accumulation .

If you are using a 2401 position computer then the dithered box should be unchecked.  For a 2503 Memory Interface check the dithered box.  This applies at all times.

 (
l!l
liJ
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I
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1
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J
)lfl1XProbe Spectrometer Setup
Spectromet er   Control   Panel	Acquision IConfigu1ation l Oeteclor\'lidth l D.il.C l V1 Cu1ves l
 (
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spot
 
·
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CenterBe	85
V\lmdow\/Vidlh    		   50 NumberOfPoint s		100 Nscans INreads      	 		    1
 (
(
)Resolution 14	::J
Scanned	rv
Horizlinearizat ion	r
Dit hered	r
Signat u1e	r
Play Motle
 (
::J
)BindingEne rgy	278
Resolulion Iii
Vr 1042.058334
V1	794 .8
Vr IOl1£1	0J(29b2b
V1 long	0J'7 c30 pass ener gy 166.596 177 1
r Collect Data	Read Once FilterCoefficient		0
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xray l xRay400 ::::J  P Operate Aperture INone	iJ
FloodGun	r
lonGun	r
Interlo ck	P'
Accessory Masl< OJ(O

This will generate a spectrum of the Au 4f.  With the cursor set at the center of the 7/2 peak, read the BE at the upper right corner of the spectrum display.


(
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(
Calibration and Set up -Establishing  starting calibration values cont.
3. Calculate the following:
New PassEVRes4 = 166 + (measured peak position - 84).
Enter the new pass energy into the configuration table and select Commit.
4:  Set up following unscanned spectrum
a. Remove the check mark from the box titled "Scanned". b .  Center BE  =  85.8.
c.  Window Width = It will use the Detector Width.  No input needed. d.  Number of data points  = It will use 128. No input needed .
e.  Number of Scans/Reads = 200
f.	Start Accumulation
After spectnun is accumulated, use cursor to measure separation between the Au 4f 5/2 and Au 4f 7/2 peaks .
5. Calculate the following:
New DetWidthRes4 = 19 * (3.68 / measured peak separation) .
Enter new Detector Width into configuration table and select Commit.
6. Make following entries :
a. DetWidthRes2 = (DetWidthRes4) / 3 b .  DetWidthRes3 = (DetWidthRes2) * 2
c. PassEVRes2 = (PassEVRes4) / 3
d. PassEVRes3 = (PassEVRes2) * 2
These starting values will now be used in the automatic program to refine the	(
calibration.





















(
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The DAC calibration is very simple. Align the copper sample under the microscope . Clean the sample with an Ion Etch.   Then select stmt.  The spectra will be displayed as they are collected.  The display window will provide infonnation as the calibration progresses .

The DAC calibration may fail to find the Cu 3sl/2 peal< in the preset window.  Small errors in the DAC constant will cause large errors in the Cu 3sl/2 peak location.  You will need to provide an improved initial estimate of the DAC value. Run a 100 Ev wide scan centered at 120 Ev and a 50 Ev scan centered at 930 Ev. Find the centers of the Cu 3s Yz and Cu 2p 3/2 peaks using the cursor. Compute :
((Cu 2p3/2 - Cu 3sl/2) energy separation I 810) * ctment DAC
Enter this value of the DAC into the configuration table.  Follow steps 1 through 3 above to re-establish the Au 4f7/2 line position to 84 Ev. Re-run the DAC calibration .
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Calibration and Set up -DAC calibration - cont.	(
The DAC calibration can leave the absolute binding energy far out of adjustment.  It is only attempting to set the separation between the copper peaks to the coITect value.
Return to the acquisition tab and collect a scanned spectrum at the Au 4f peaks . Use the following setup:

CBE	85	Res	2
WW	30	Scans  2
Nbr Pt 300	Scanned box checked X-Rays on - 600 spot














(
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(
Calibration and Set up - Detector Width Calibration

Use the cursor to find the center BE for the Au 4f 7/2 peak. Find the value of PassEVRes2 in the configuration table . Calculate:

New PassEVRes2 = cmTent PassEVRes2 + (measured peak position - 84).

Enter the new val ue of the Pass Energy into the Configuration Table. Make the same calculation for Res 3 and Res 4 but use the Res2 value  (measured pealc position  - 84). Enter these two values into the configuration table.  Select Commit to record all three updated values to the registry.

Select the Detector Width Tab. Set the run conditions for Res2, Res3 and Re4 as shown below.  Select strut. Watch the calibration proceed.  Ifthe calibration fails to find two pealcs it is usually because the pealcs are not well enough centered in the window . Make small changes to the pass energy as described in the paragraph above to center the peaks and try again. This calibration sets the absolute BE for all pass energies.

Note: Increasing the pass energy moves the pea ks to lower BE.


(	Acquisition J Configuration	DetectorWidth J DAC  ] V1 Curves ]
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(

Calibration and Set up - VI curves

This calibration is only needed if the VI supply is digitally controlled.  The VI curves settings will have no effect on a model 8701 Spectrometer supply unless the supply has a digital VI upgrade.  The optimum voltage setting infomrntion may be useful for manual adjustment of the supply.

1,1XProbe  Spectrometer   Setup	l!!I
Acquisition J Configuration J DetectorWidth J DAC	V1 Cwves  j
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	New Values
	Rst!:Y_ Values
	

	
	Slq.Q.e	jlntercBQI
	SlojJ_e	J!ntercBQI
	

	
	
	0.42	59.86
0.44	84 .02
0.49	142.72
0.55	226 .86
	



The VI curve generator.

The object ofrunning V I curves is to obtain a set of parameters that optimize the lens throughput for all binding energies.  The voltage (VI), that is used to focus the lens, is continuously increased over a range of voltages. As the V I voltage is changed the number of electron that reach the detector is changed.  The goal is to set a start and end for the VI voltage ramp that produces a maximum detector signal away from either end.
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'	(	Calibration and Set up - Vl curves - cont.
Each Resolution requires two VI curves . All curves are created using gold as the sample. The spot size setting does not affect the final Slope and Intercept values.  It is best to nm with larger spots to improve the signal to noise.

The Check boxes, under the include column, control which curves will be run. The button labeled "Run Test" will stm.t the data collection.  After all pairs, that have been checked, are run use the calculate button to calculate the Slope and Offset parameters. These parameters are used in the software to compute the V l voltage as a function of VO (retardation) voltage that will keep the lens focus optimized for all binding energies.
Review the computed values. The slopes and intercepts should increase -smoothly and the resolution number is increased.

Finally select the update registry button to make the new values take effect.
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(
Calibration and Set up - Signature correction

Return to the main Capture program

Select the Capture Settings dialog.

ii;, Esca Capture (C:\Program Files\Esca 2000\examples.mdb)	-'   ]';
II Ejle  IJ.iew rSettings  tielp  E it
j D _d-}	Set System Registry DefauIts


r. Recipe
r E:<peiime

on
Edit 5cofleld Table Set up ESCA

[image: ]

Performance test
-;;; Position Table Blank
!';; SarnplE: Pr oject


X·Rays	]	Spectrometer     I
 (
I
)IrSigniture Correction OM
1   Signature File Path:  lc:\Program Files\ ESC.<1. 2000\ ig.t>:t
I r Dither

Jill

Ar ea I



Peak

i .'\

I r Horizontal Linerization

.!! _ _ _ _  -·-- -






:: .:: -----
350    -	-  -

I
L_ _	 	
!;ancel





_	_ J

"'	r -·-- --- -------- - - - ----- - - - ------....


Ifthe ESCA uses a Model 2401 Position computer then the Dither box should not be checked . Check the Dither box if a Model 2503 Memory Inte1face is used.

Remove the checks from the Signature Conection box and horizontal linerization box.

Enter the Signature File Path as shown above. This ·will stop the "Signature file not found." message that is shown when the program is staiied.

Select update and close the dialog box .

Ifyou have a history of signatures in the C:\Program files\ESCAVB folder, the files can be moved to the C:\Program files\ESCA 2000 folder. These files will have the following endings : sig.txt.1, sig.txt.2, sig.txt.3 etc. Copy all files in this series.
(
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(	Calibration and Set up - Signature correction cont.
Place an Unscanned Function in the MRS table. Set the CBE to 510eV. Input the time as 10:00 to set it to 10 minutes . Set the spot to 800 microns and the resolution to Res4 . Use Default and Temp for the Project and Experiment. The collected data does not need to be saved. The computed signature file is saved.

Select Run.


II Elle \1!i>W   !:Jtlp Settin?'  E,' !
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r. Experiment
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Save as Default and Temp

END
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After the data has been collected just leave it displayed.  Then select the Setting > Create a new signature file menu.
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Select the capture button . The signature will be computed from the data in the spectrum display window of the main program.  The signature will be displayed inthe signature window.
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Calibration and Set up - Signature correction - cont.	(
Select save to save the sig.txt file and back up the last sig.txt as sig.txt.1 .   All other sig files will be rolled to the next higher number .

Close Signature conversion dialog.

Re-Open the Capture Preferences dialog.  Settings > Capture Preferences in main toolbar. Enter a check in the Signature Correction check box.

ii;,Esca Capture (C:\Program Fdes\Esca 2000\eHamples.mdb)	-	-i
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Set up and calibration is now complete.
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(
Database Functions

It is highly recommended that each user create a personal Data Base!
Click on File > New > New Data Base /Protocol .	·
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(
Database Functions -Creating a new database

Enter the new data base name then select Save.
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Save jn:











File name: Save as !.Y


@ examples.mdb
@ Programdb.mdb
@ start.mdb







'.mdb		_!2.ave	.,
Cancel	I
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The categories Depth Profile, Performance Test, Position Table Blank, and Sample Project will be automatically loaded with each new Data Base.
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(	Database Functions - Get recipes from another database
Recipes can be transferred from one Data Base to another .
Go to File > Open > and select the Data Base into which Recipes are to be transferred . Now go to File > Get Categories/Recipes
 (
·
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Save 8,s • . .
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)C:\Pro•;ir am Files\ESCAVB\.DAK -new.rndb C:\Program  Files'1,ESCAVB\l(oz. mdb C:\Program  Files\ESCAVB\DAK-new  .rndb
[-·- _c_:\_P_r og__ra_rn_File__s\_E_s_cA_1_1s_'1,_K_o_z_. _n_db	........,

Highlight the Data Base that contains the Categories/Recipes to be transferred and click on Open.




Highlight  source Database .


ESU>.VB
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start.rndb




Open




File name:	]Koz. n-1db


Files of type:



(


l ".mdb
r 0 pen as read-only
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Cancel





(
Database Functions - Get Recipes from another database - cont.

 (
!
!
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TRANSFER
 
OR
 
ALTER
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TEMPLATE
 
DATA
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ESCA
 
Template.md
 
b
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Programdb.
 
mdb
!
!
)


Inorder to h·ansfer a Category and/or the Recipes highlight the Category and hit the space bar (note that after highlighting a Category or Recipe, hitting the space bar toggles the (-), (+) signs in front of the titles) .
Highlight and hit the space bar once for each Category and Recipe that is to be transferred, then click on the Copy button.
Ifa Category is showing a (+) and all Recipes below the category show (-) then all Recipes in the Category will be copied. This saves the effo1t of checking all Recipes.

If a Recipe shows(+) but the Parent Category shows (-) the Recipe may not be copied. If the target database (the one you are coping to) has a matching Category then the marked Reci pes wiJJ be copied.
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(


Depth Profiles - Open the depth profile table generator.




 (
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1. Select the Depth Profile function from the function list.
2. .		We suggest that the first Template be a default Template.  Use this as a temporary table .  It is rare you will reuse a Depth Profile .  Continue to step 4 if you are going to write over the default template .
3.	If a reusable template is desired then select New. Edit the Template Name. Go onto next step to define the spectrnm regions .
4. Use the Add and Delete buttons to create a table of Region Definitions
a. Region name is typically the element symbol and transition label. When this convention is used, the data reduction will automatically identify the transition and look up the Scofield cross-section .
b. CBE - Center binding energy
c. Scanned - checked  WW (window width) must be entered with a non 0 value.  Scans is number of scans. If a time is entered as hh :mm:ss, then a number of scans will be calculated, but not shown, that equals or exceeds the time.  A default eV/step will be offered.
(


35







Depth Profiles - Cont.	(

d. Scanned -not checked. WW defaults to detector width, Scans/Time is collection time and can be entered as seconds or hh:mm:ss and finally eV/step is not required .
e. You need to enter a Resolution number in all cases.
f.	Hh:mm:ss can be entered as h:mm:ss,  mm:ss or m:ss.


5. Set up the Spot Size, Etch Time in seconds or W1:mm:ss, Flood gun state and Number of Etch cycles.
6. The Rotation can be "On" or "Off '.  Ifrotation is "On" then the sample holder will rotate an integer number of rotations during each etch cycle.
7. Select Paste to Save the Table and Close the Depth Profile Dialog.
8. Use the ESCA Control Panel to set up and test the sample alignment, and ion gun operation.
9. When ready select any of the Run Buttons.
10. The Spectrnm Viewer will display the Depth Profile during the etch cycle.



(
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(
ESCA Control Panel

Previous versions of the software used A Quick as a simplified control panel.   This update replaces A Quick with the ESCA Control Panel.

The first row of the panel presents check boxes allowing for the activation of the Flood Gun (charge neutralization), Ion Gun, X-ray Gun and, if applicable, Aperture.
Changes in these parameters take effect when the boxes are clicked .

The second row and third row are grouped together in a frame.  The fields represented in
the frame directly control the spech·ometer.  The Panel is shown with the scan variable
/  not checked.  This is the UNSCANNED mode.  The active variables are (CBE), Spot size, spectrometer Resolution, and Capture T (time in seconds). Changes in these parameters take effect when the stait button is clicked.

ESCA Control Panel - Unscanned mode
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ESCA Control Panel - Scanned Mode	(
Placing a check in the Scans box provides access to Scans number, Window width,
eV/step, and Time/step.
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(
ESCA Control Panel - Quick survey.

Place a check in the Scans box, type 500 or 550 into the CBE box and 1000 or llOO
respectively in the Window box.
Set Time/step to 50 and click on START.
Note : The overhead time per step is 25 milliseconds . This is not included in the Scan time calculation .
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Very large display of Count Rate.




This display can be expanded and moved.
Additional status parameters are then
displayed. Available during normal capture.
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(
Calibrating th e Microscope for Correct Sample Registration

Place a phosphor sample on a flat stage and transfer it to the UHV chamber. Use the joystick to manipulate it to the vicinity of the registration point.
Turn on the Flood Gun, and X-rays. Set the CBE for O(l s) at  532 eV.
Choose the largest Spotsize, Resolution 4, and a large number for Capture T (3000seconds?) .
While monitoring the counts adjust the Z-axis of the stage for maximum counts. Also, insme that the "dot pattern" on the CRT is centered (side-to-side) .

NOW, UNTIL THE MICROSCOPE HAS BEEN CALIBRATED, DO NOT USE THE JOY STICK OR DO ANY OTHER MANIPULATIONS TO THE STAGE.

Tmn off the flood gtm (the flood gun emission may make the area in-adiated by the X-rays difficult to see).

Use the 50X magnification and the eyepiece cross hairs, adjust the Z-axis of the
microscope so that tne irraCiiated area of the phosphor is in focus.
Now use the microscope's X and Y-axes controls to move the eyepiece crosshairs to the center of the in-focus i1rndiated area on the phosphor.
Ifa small Spot size is to be used change the Spot size settings to the appropriate size and	(
recheck the crosshair alignment using the microscope X and Y-axes adjustments. The microscope is now calibrated.
Now use only the joystick controls to bring samples into focus and areas of interest tmder the eyepiece crosshairs.
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(
Experiment Names as part of the database structure

The Project and Experiment Names are displayed in a number of places in the program . The two names together fonn a unique identity for a MRS, Depth profile or one position in a position table. Examples of the tree structures that help to find your data are shown below.

I Re.cioe	[image: ]
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Experiment Name - Name entry box.
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Data Analysis keeps Reduced data with Raw Data for ease ofrecovery . Raw data is never presented for manipulation.  Only a copy is presented in the Spectrum Viewer.
(
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(
Graphics controls -Chart editor

 (
I
·
1
!
·    
 
I
 
A
r
e
a 
j
 
P
eak
 
I
 
Auto
 
E1
n
d
 
j
 
I
o
o
l
s
 
j
 
.
A
J
 
Dp
 
I
j
I
,,
!.
2
 
4
1
(    
 
- 
 
-·
 
;
 
-
1
 
·
l
I
,
.
:
:
:
,
:
 
L
e
7
:
'
 
.
,
'
'
:
j
:
'
j
 
-f)
 
j
 
[
,
l
 
I 
©,
Editing
1
 
1 
P
1
oj
 
N
ame
:
a
_
 
 
-11
[
"
[
:
:
I
'
"""
 
I
Se
1
ie
.
s
 
\
 
Ge
n
e
1
al
?
 
?
1<
     
 
• 
 
•
 
_
_
•
 
_,.  
 
_
 
••
 
,
 
_   
 
•
 
•  
 
;
 
_  
 
•
p-
 
2_
h
ow
 
A>i
s
l!D
 
View
 
Propertle
 
 
 
•
-
 
D 
 
X
A>h   
 
l
T
 
1ti""
 
\
 
Legend
 
i
 
Pane
l
 
i
 
Pag
i
n
g
 
\
 
Wa
lls
 
\
 
3D
Sc
a
l
e
 
I
T
i
tle 
 
l
 
L
abe
l
s
 
l
 
T
i
c
ks
 
\
 
M
inor
 
l
 
P
o
s
 
i
on
 
l
p-
 
a
ut
omatic
··
Rotation
_:i
=:-
J
 
_
Zoom
-
[
 
-=---
 
-=-
Elev;;tio
n
A>:
i
s:
r.
·
 
L
e
ft
 
r
 
fl
i
ght
 
r 
 
l
op
r
 
12'\tmr
l
r
 
Q.
ep!
h
P-
 
6.Jl
 
O
w
 
l,1.ilg
t.r_i.r1
Jf·
     
I
 
Ma
>:i
rn
u
m:
 
2,
521
c
h,
;
1-1g.:
 
..
 
I
 
r
 
1inim1Jff(
 
1
_:l
_
 
_
B
_
Pers
p
ec
l
ive
 
_
£
h
a
n
ge...
 
 
I
D
e
s
i
red
 
l
11c
r
eme
n
t:
 
1
r
 
Loga
i
i
t
h
roic
r
 
!
nve
1
t
e
d
l
 
11
P-
 
\[
i
si
bl
e
 
-
-
_ 
 
·
---
 
.:c.
2
_
s
o
 
-
...;;;;
=
l
:
:
:
!
e
;
;
;
l
;
p
;
:
.
;
.
.
;
;;;;;;;;,
_
-
=
=="'""""'
;;;
;
c
;
;
1
o
;
;
s
;
:
e
;;;::;;;;:;
:
l
:
.
.
.
_
,
 
=
·
)

The chart editor provides control over all aspects of the Graphic presentation of the spectra.  In the following sequence of screens we will show some of the typical controls.

The X and Y axis presentation is controlled on the Axis > Scales page. The "Axis"
column in the left frame controls the focus of the "Axis" sub pages.	(
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Removing grid lines for X axis.  The axis control was changed to Bottom to remove the vertical grid lines in the next screen.
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tJrapnics con1.ro1s - cnart ta1tor -cont.
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The above sequence shows a few of the capabilities of the Graphic Editor. Many Fonts, font sizes and colors are available.  Legends can be created for Graphics with overlays. The panel background can have be a blend of two colors. An depth profiles can be displayed in 3D.
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(	u raJJll!C LOlllTO! - t'nnt Utlllty

The General Page of the Graphic Editor provides access to a Print Utility and Graphic Export.
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The Print Preview can be obtained from the Printer Icon or from inside the Chart Editor. The Chaii Editor provides more flexability . The Printer Icon provides convience.
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(	\Jrap1uc LOlllTOI - :")pectmm color
The color wheel icon provides access to the "Change Color and Line Style" dialog.
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The spectrum displayed in the Graphics Viewer can be placed on the Windows Clipboard by ciicking on the Clipboard Icon. The image is available for pasting into any Windows program.
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The tilt stage allows for computer controlled variable takeoff angle (TOA) analysis. With the Motion Control Panel open select the PT M function and open the Position Table dialog. This will enable the "AJlgle Setup"button on the Motion Control Panel. Click the "Angle Setup" button on the Motion Control panel to display the Tilt Setup dialog.
(
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(	IVIotio:n Control -Angle Resolve an. d tilt stage setup - cont.
The relations ships described in the Tilt Setup are pictured below .


Takeoff Angle






Sample normal

Lens axis



TOA - Surface to Lens Axis - as
\ .	shown in example.
)

 (
r
)J ==========£Sample  surface  J

Tilt Stage
Shown with bearing support on right.

(	slot in machined
aperture plate	bearing
support


(


49







Motion Control -Angle Resolve and tilt stage setup - cont.	(
The tilt stage allows for variable TOA analysis and by rotating the stage about its X-axis. The TOA can be varied from 0 to 90 degrees.  Mount the sample by placing it between the solid bottom platen and the machined apertme plate .

Tn order for the software to work properly the following conditions must be met;
The microscope must be calibrated (refer to the section Adjusting the Microscope for Correct Sample Registration on page #17).

Place the sample/stage in the preparation chamber so that the bearing supp01t is located on either the left or right side of the stage.

 (
Lower
 
the
 
Z-axis
 
to
 
the
 
minimum
 
1
>osition
 
before
 
transferring
 
the
 
t
i
lt
 
stage
 
to
 
the
 
UHV
 
cha
m
ber. 
 
This
 
is
 
a
 
precautiona
 
ry
 
step
 
to
 
avoid
 
collisions
 
of the
 
tilt
 
stage
 
with
 
the
 
hardwa
 
re
 
that
 
protrude
 
into
 
the
 
analytical
 
chamber
 
(i.e.
 
flood
 
gun,
 
lens,
 
ion
 
gun).
)

Raise and manipulate the stage and superimpose the microscope eyepiece crosshairs on the grid line of the stage.
This con-ectly aligns the tilt stage with the X-ray beam and the lens and the R controller
will now tilt the stage.
(
In this example a TOA of 35° (sample surface horizontal or flat) will be initially defined as home (0, 0, 0, 0).  An approximate setting of the horizontal is sufficient for this initial setting.
a		Using the unscanned data acquisition mode and a strong elemental line adjust the Z-axis for maximum counts and click on the SET XYZ Home(see next page).
b Now use the Y-axis to move away from the tilt axis (d o not move Z).
Ifthe counts and signal (dot pattern on the detector) remains constant, then the stage is positioned con-ectly at TAO of 35° (or 55° if using the lens axis to sample normal as the definition of TOA).   Ifnot use R (low speed) and adjust the tilt for maximum counts and click on SET R.  This accurately sets the horizontal plane
c Use GOTO home XYZ to return to the tilt axis.  Check and refine the alignment of the grid line on the top machined plate so that it overlaps the microscope cross hair.
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(
).
iv_1_ouon Lon1ro1 -Angle Keso1ve anct tllt stage setup - cont.

Aligning Sample for Angle Resolve Analysis

	
 (
slot
 
in
 
machined
::inP.rtmP
,
 
nl::itP.
I
I
I
!_---J
)Use Z-axis controller
tf\ ,:\Jl o-n <'PntPt' f\f
sample_
Click SET XYZ...










1--

Use the Y-axis and/or
 (
J
-
)R to align an area	I
away from center.
I--:S-----".---==Click=SET=R .    =:;J





Note angles entered in the R column inthe position table on page 42 . Enter the set of angles you plan to use in the experiment. Use the add line, delete line etc to organize the table as you choose.
(	The steps completed to this point are:
1. Select the tile configuration in the Tilt Setup dialog. Close dialog
2. .	Align the Home condition for the tilt stage as outlined above.
3_		With the Motion Control Panel Measurement System set to degrees enter the tilt angles for your experiment.

Now Select the Tilt Measurement System (see pg 42) in the Motion Control Panel .  Your input numbers will be conve1ted to Raw motor steps. This conversion will account for the tilt stage gear ratio and the Tilt Setup configuration.  The final table is displayed below.
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The Recipes are assigned by selecting the Recipe Display Mode and selecting the Recipes from the dropdown dialog.
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(	ivi.on.on Lont
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:ro1-


tna01e1u1sao1e uuttons








Review the last three screens that show the Motion Control Panel. Notice the Motors and Joystick buttons take on the colors Red, Yellow and Green depending on the state of the Motion control system. Clicking either button will toggle the state of the Motors or the Joystick between enabled and disabled (Green or Red).
(
1. Disabling the Motors turn the power to the motors off.
2. Disabling the Joystick block Joystick control of the motors.

The yellow state is displayed during computer-controlled movement. Notice that a number of control panel buttons are disabled during computer-controlled motion .

NOTE : Ifthe motion system stops working it is often sufficient to Disable the Motors and then re-enable them to restore normal operation. Your Home position will not be lost.

Motion Control - Home controls



Set current (x,y,z)	l
position  to (0,0,0)


Home Controies-----y-­
---r-..:::::Oo':v.cstk home enabled



r Set Ctment (r) position to (0)

SET	XYZ  l_R	,

Ir Moves stage to

_r=-

XYZ l :_R:_y=:-:- r--	-­
 Nloves rotat10n 	

 (
GOTO
)l(x,v,z) = (0,0,0)

to (r ) = ( 0")


The GOTO R button causes the rotation position to return to 0 deg or 360 deg.
(
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Motion Control -Mode control of the Joystick buttons (6K4).	(
Configure	['":Jo!sricK''"!'
Motors	i buttons	1!
-  ···················..·:·..j
Home  Controles----


SEi GOTO

_!('r'Zj	R·
 (
I
)X'r'Z   l_R




Configure
Motors


Joystick
buttons


	
Home Controles -----, Joystk home enabled
SET	>«Z  I	R
GOTO     XYZ  I	R 	



Clicking the "Joystick buttons" button toggles the function of the two front buttons on the
Joystick.  When the Joystick home is enabled, then the left front button set the current	(
XYZ position as home.  Likewise, the right front button will set the current rotation
position as home.  This is very convenient for initially setting a home position while observing the sample with the microscope.

Later, when reviewing the learned sample positions, the mode can be switched. When the home function is disabled in the Motion Control Panel then the Joystick Step Next/ Step Back Function is enabled in the Position Table.
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The joystick controls motion along the X (left/right), Y (forward/back) and "Z axes (press center button while moving the Joystick forward-back) . Rotation is obtained by twisting the outer ring clockwise/counter clockwise .

The Get function "Gets " the current coordinates and fills or updates in the position cell in the position table .
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l\'lotion Control -Panic Button

 (
The
 
PANIC
 
button
 
is
 
used
 
to
 
immediately
 
stop
 
all
 
motion!
)
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All motion is stopped and power is removed from the motors.   The current home location is not lost.

To restore normal operation select the Motor button and then the Joystick button.  AHer both buttons turn green, the Motion system will be ready for operation
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(
Nlotion Control - Position Table Setup

 (
Setting
 
up
 
the
 
Position
 
Table
 
disables
 
Recipe
s
 
so
,
 
when
 
possible,
 
compose
 
Recipes
beforehand
 
.
)

Use the Function pull down menu and select PT M.  Then click the design button ("The Pencil") Icon.  This activates the Position Table - Multi Recipe Panel.  Ifthe Motion Control Panel is not open it will be opened along with the Position Table.











PT M Function
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Set Home

Go to the microscope and set the cross hair on the axis of rotation .   Go to the SET row of the MOTION Controls Panel and click on XYZ.

Move toward the edge of the holder, preferably the first sample.  SET this position as Home for R.   An initial reference co-ordinate system is now set that can be reproduced if there is a glitch.
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(
Motion Control - Position Table Setup cont.

Lea rning Positions

There are two modes of adding rows to the position table.  They are controlled by the radio buttons in the Get Cmrent Positions frame.

1. Select the Update mode. Each time the Add Line button, on the position table fonn is clicked, a blank row will be added to the table. When the Get Position button is clicked the values for each axis will be updated.
2. Select the Auto Add mode.  Rows are added and filled in each time the Get Position button is selected.

The Update mode is convenient for updating or refining the coordinates for an existing table.  The Auto Add mode is best when building a table from scratch.

NOTE:  The Joystick Get Position button works the same as the button on the form. With Auto Add selected, you can learn all your positions without going back to the computer.

 (
(
)Choose one of the above modes of operation . Put the cursor on the X axis cell of the first row.  Row (1). The X axis cell is arbitrary but a good practice.  With the stage aligned on position, (Pos 1) click the Get Position button on the Joystick or on the Position table fonn.  The Special Function button is the Get Position button for the old Joystick.  Ifyou chose the Update mode the coordinate cells of row (1) will be filled . Ifyou chose the Auto Add mode then you will have a new row at the bottom of the table with the values for the ctment position.

In the update mode, you will continue to put the cursor on the X column of the row that matches your sample. You will move to a new position and select the Get Position button .

In the Auto Add mode you will continue moving to new positions and selecting the Get Position button. When you are finished, delete any rows left over from previous tables. You will then be left with a table properly numbered .

The screen on the next page shows the controls discussed.
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- - Yosmon l ame ::setup cont.
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NOTE: With the GPIB/2100 Indexer system the Joystick operation is not connected to the computer.  Continuous polling of the Indexers to see if there has been Joystick activity leads to less reliable operation.  The "Goto or Get" button on the Motion Control Panel is used to req uest current stage position.  This provides the req uired
update.  The Motion Control Panel button ONLY upda tes the Motion Control display.  The Get Position Button on the Position Table and the Joystick update both the Motion Control Pane!and the Position Table.
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Motion  Control - Position  Table Setup cont.	(
After the desired positions have been entered into the Position Table click on the Recipe button.  This expands the Position Table - Multi Recipe Panel so that Recipes may be assigned for each position .


Save the table and Run the analysis.
•,-.-Position Table - Multi Recipe

-1l Save.	J
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.'ulo add	Gi-flt ,	Depth Profiie:Fiecipe

//---

 (
l
)!-_ _=U-:-pdate__ _

_   P_ositio_n

Depth Proiiie:.O.u on SS
.0·ept1 1 pro11-1e:.,'-'.u on c..;-:;
 (
,
 
.
.
 
.
 
-·-
 
·
-
-
 
·
-·
 
·
 
)- Depth P1ofile:.6.u on SS


t>.dd Line	Del Line

t 1 Performance test: Gold Dia· nal
...

 (
P
o
s
iti
on
2
3
2
3
;\
TEST:test
 
2
 
Po
s
iti
o
n
 
Ta
b
l
e
 
Blank
:
F
e
 
R
 
 
i
...
),	,Position T able Blank:Cr Regin
Position Table Blank:,6.u reaio

... y

z	F:

.....
-





Descriptions and/or comments may be
inserted  here.	_)

0.00	0 00	47.00
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...
)1.00	1.00	1.00
 	2. 00	2 . 00	2. 00	2. 00 	
(




If, after acquiring the data set, more data is needed, create the appropriate Recipes and insert them into the previous position table.
Then Save again.

Previously stored position tables may be reused and edited to accommodate different sets of samples.

Motion Control - Rotation
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-iii°.-EstaLlish Motor Configuration

Ple!'se select one optior1 for the M otion Control	 	 i nte1f.3ce.


- M otion Conttol I nterf ace------
r M one
(
1. 
No Motors then use "None "
2. . National GPIB card us 2100 Indexers with HPIB.




 (
-
,
)Please check all installed a:,es.
I nstalled />.xes--------
w	X Axis	On new instailation s, check all
installed axes.
p	Y .6.xi s	Ifa fault message suggests you
p	Z .l\,xi s	should uninstall  a motor, remove
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) 

This configuration dialog will be displayed when the software is first installed .  Your responses will be stored in the registry.
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(
Motion Control -Units, coordinates.


 (
Read
 
only
 
-
 
Ctment
 
position
 
 
raw
 
Manual
 
eniry  -
 
(X,Y,Z,R)
)

XYZ Scale units are:
1. mm = millimeters
2. inch = inches
3. raw = number of motor steps (250,000 I inch) R Scale units are:
1. deg = degrees
2. . raw = number of motor steps (36,000 I tum - 6K4 or 25,000 I turn GPIB)
3. tilt = converts TOA (Take Off Angle) to raw. See Motion Control - Angle Resolved.

 (
(
)Enter position coordinates and then click Goto (or keyboard Enter) for manual control.  If no position coordinates are entered (i.e. White boxes are empty) then the cmTent motor positions will be recovered from 2100 Indexers . This is not required with 6K4.
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 (
.
 
=
)iv1onon LOlllTO! - v e10cny	etup (liPlH w1t 1 l.1UO lndexers only)

The Velocity Setup only controls the velocities for computer, not joystick control.

[image: ]	[image: ]
The veiocit)' settings are in mm/sec or deg sec. These settings only control the velocities for computer control. The joystick velocit ies are set manualy in the 2100 indexers.


[image: ]

X Axis	j o.5	0.1 to 5 mm/sec


Y Axis	j o.5	0.1 to 5 rnrn/sec


Z Axis	J o.5	0.1 to 5 mm/sec

(	R Axis	j o.5		1 to 180 deg/sec Cornrnand1
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(
MRS Tables

A captme screen, with a new database loaded, will show no MRS table.  Select a Recipe to load the MRS table consh1.1ctor functions.
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In this case the Sample Project > Default Recipe was selected.  The MRS for this Recipe is a simple survey.  We can start from this MRS and modify it to create the parameter table for the Spectrnm captme desired. First, a review of the possibilities.
(
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(	1\ilRS Tables - Construction by selecting and editing Functions.




Adding a new function.
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(
lVIRS Tables - Construction buy editing Functions cont.
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A Function (in this case a Survey) creates a list of default data acquisition parameters. The default values are often ok but it is quick to customize the values. For example, the number of Scans is often increased or the BE conditions are changed.

NOTE:  Time, stated as hh:mm:ss, can be entered instead of number of scans.  The program will compute a number of scans that most closely matches the requested time. A calculation of zero scans will be run as one scan.

The default parameter eV/step is set optimum for the selected resolution  (Res#). This applies to high resolution (ResHi) and high Sensitivity (HiSen) scans.
(
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.fd" RS Tables - Construction by editing Functions cont.
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High Resolution scans and High Sensitivity scai1s may be added to the table as required by the analysis.   For these two cases the binding energy is changed form the default values.   This is quickly accomplished  by "An·owing" down the BE column.
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The above Multi Region	can (I"vfRS) has a sw-vey and four high resolutions Region. Each region has been named for ease of identification.  The region name will default to Region 1,Region2 etc if the names are not entered.
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MRS Tables - Templates	(
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The table above displays three templates for the high sensitivity function. After selecting a function you can drop-down the list of named templates that hold a set of default
values. For frequently 11sed parameter sets you may vvant to defme }rour O\vn set of
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To create a new template:
1. Select the New Icon.
2.	Enter a new Template Name .
3.	Enter the parameter values for your template in the appropriate boxes.
4.	The check box will lock the value so it can't be changed from the MRS table.
5. .	Select the Paste Icon to save the template and post the name to the Function
list.	(
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Befor running the MRS table a Project Name and Experiment Name must be provided.
These two names taken together create a unique idenity for the MRS in the database.  The
(	Experiment Description is for additional information that make clear the Experiment.
The discription is not used for finding the data.  It is supplied after the data is recovered .

Most of the time there wlll be a Project Name and Experiment Name in the input boxes . These names will be left from the previous state of the Capture Program.  It is most likely you will not change the Project Name . This assumes that you will do many Experiments for one Project.  The typical operation will be to write over or modify the Experiment Name.  You may add letters or numbers to show a sequence in the experiments .

 (
Three
 
Run
 
Controls
 
are
 
found
 
abov
e
 
th
e
 
Function
 
Table.
 
The
 
lines
 
in
 
the
 
Function
Table
 
can
 
be
 
run
 
to
 
capture
 
a
 
sequence
 
ofregions
 
.
The
 
Run
 
button
 
runs
 
the
 
complete
 
Function
 
Table
 
from
 
line
 
1
 
to
 
the
 
bottom
 
of
 
the
 
table.
 
The
 
second
 
button
 
labeled
 
One
 
only runs
 
the
 
current
 
active
 
(highlighted)
 
line.
The
 
bottom
 
button
 
labeled
 
End
 
runs
 
from
 
the
 
current
 
active
 
line to the
 
bottom
 
of
 
the
 
Function
 
T
a
ble.Once
 
a
 
capture
 
is
 
started
 
a
dditional
 
buttons
 
appear
 
to
 
control
 
t
e
1
mination.
)After taking care of the Project Name, Experiment Name and Description Select a Run Control.
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 (
Pause, Stop
 
,
 
Abort
 
and
 
Append
 
buttons
 
appear
 
to
 
the
 
right
 
of
 
the
 
three 
nm
 
buttons.
·
r
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I
r.
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1
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1
I
Pause
 
-
 
MRS
 
t
a
bles
 
. 
 
Pause
 
will
 
temporarily
 
stop
 
the
 
capture
 
so
 
a
 
change
 
can
 
be
 
made
 
to
 
the
 
number
 
of
 
scans
 
or
 
capture
 
time
 
.  
 
In
 
order
 
to
 
continue
,
 
click
 
again
 
on
 
Pause
.
Pause
 
-
 
Depth
 
Profiles
 
.  
 
Pause
 
will
 
temporarily
 
stop
 
the
 
capture
 
of
 
a
 
scan
.
 
 
During
 
the
 
pause
 
the
 
etch
 
time
 
or
 
number
 
of
 
cycles
 
may
 
be
 
changed
 
. 
 
In
 
order
 
to
 
continue
,
 
click
 
again
 
on
 
Pause
.
 
 
If
Pause
 
is
 
used
 
during
 
the
 
etch
 
cycle
 
the
 
cun-ent
 
etch
 
cycle
 
will
 
finish
 
and
 
then
 
the
 
Paus
e
 
will
 
be
 
executed
 
.
Pause
 
-
 
Position
 
T
ables
.
 
Pa
use
 
w
ill
 
effec
t
 
th
e
 
MRS
 
t
a
bl
e
 
of
 
t
h
e
 
cmTe
nt
 
p
osi
tio
n.
Pause
 
-
 
Ion
 
Etch, 
 
The
 
stand
 
alone
 
Etch
 
function
 
will
 
pause
 
during
 
the
 
etch
 
.   
The
 
etch
 
time
 
can
 
be
 
changed
 
.
S
top
 
-
 
M
R
S
 
Tab
l
e
.
 
"
Sto
p
"
 
is
 
used
 
to
 
s
top
 
a
 
scan
 
at
 
the
 
nearest
 
endpoint.
 
I
f
the
I
 
capture
 
is
 
unscanned
 
t
hen
 
the
 
cap
t
me
 
will
 
st
op
 
immediateiy
 
.
Stop
 
-
 
Depth
 
Profiles.
 
"Stop"
 
acts
 
as
 
an
 
abort
 
during
 
a
 
the
 
Depth
 
Profile.
Stop
 
-
 
Position
 
T
a
bles. 
 
"Stop"
 
will
 
stop
 
the
 
Position
 
Table
 
MRS
 
at
 
the
 
end of
 
the
r
u
1
m
1
ng
 
spectru
1
n.
 
Tl1e
 
Position
 
table
 
v
v
tll
 
be
 
a
borted.
A
bort
 
stops
 
all
 
operations
 
immediately. 
 
The data
 
taken
 
up
 
to
 
the
 
time
 
of
 
the
 
A
bort
 
is
 
saved.
Append
 
:
 
Normal
 
operation
 
is
 
Overwrite
 
.
 
If
a
 
new
 
experiment 
 
name
 
is
 
not
 
entered
,
 
t
h
e
n
 
t
h
e
 
r
e
-run
 
o
f
 
the
 
crn
T
e
nt
 
ex
p
e
ri
m
e
nt
 
o
v
e
1
w
r
i
t
e
s
 
t
h
e
 
e
x
isti
n
g
 
dat
a
.
 
I
f
you
 
want
 
to
 
collect
 
additional data
 
under
 
the
 
current experiment name
 
then
 
you may
 
use
 
the
 
Append
 
mode
 
.
 
This
 
can
 
be
 
used
 
to
 
add
 
a
 
new
 
region
 
to
 
the experiment
 
or
 
to
 
collect
 
additional
 
data
 
for
 
one
 
or
 
more
 
regions
 
.
 
The
 
Appended
 
data
 
may
 
easily
 
be
 
added
 
to
 
the
 
original
 
data
 
by
 
using
 
the
 
Add
 
Spectra
 
function
 
in
 
the
 
Tools menu
 
.
 
The
 
Append
 
mode
 
rev
e
1
1
s
 back
 
to
 
th
e
 
o
ve
rw
r
it
e
 
mod
e
 
after
 
th
e
 
A
pp
en
d
e
d
 
dat
a
 
has be
e
n
 
coll
e
c
te
d
.
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)l'VIRS Tahies - Run dis_piav	(

The data being acquired will be visible in the Spectrum Viewer .
During data acquisition binding energies may be measured by placing the cursor on the peaks, their binding energies can be seen below in the Display Bar.
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Capture  Status	Display Bar	Scofield Table	(
		




 (
The
 
Spectru
 
m Viewer
 
is
 
used
 
to
 
display
 
the
 
cmTent
 
active
 
spectrum
 
and
 
it
 
will
 
always
 
be
 
displayed
 
in
 
this
 
window
 
during
 
data
 
acquisition
 
.
Below
 
the
 
Spectrum
 
Viewer/
 
Document
 
Control
 
area
 
is
 
a
 
display
 
bar
 
that
 
shows
 
the
status
 
of
 
the capture
 
process.
Du
r
ing
 
a
 
c
ap
hlt'
e
 
t
h
e
 
Idle
 
indi
c
ator
 
w
ill
 
switch
 
to
 
R
u
nnin
 
g
.
The
 
information
 
inside
 
of
 
the
 
parenthesis
 
will
 
show
 
the
 
Recipe
 
that
 
is
 
being run
 
.
 
Additional
 
parameters
 
of
 
the
 
capture
 
will
 
also
 
be
 
displayed
 
in
 
this
 
window
 
.
The
 
next window
 
in
 
the 
Status
 
Ba
 
r
 
displays
 
the
 
cursor
 
parameters
 
.
The
 
third window
 
displays
 
the
 
Scofield
 
Ta
 
ble
 
showing
 
probable
 
peak
 
assignments
 
as
 
a
 
ftmction
 
of
 
curso
r
 
posit
i
on
.
)
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(	Next section is Data Analysis

The data analysis provide for Compositional Analysis, Peak Fitting, Depth Profile analysis and other data manipulation .
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)To open the Data Analysis from the Capture program Click on View > Data Red uction.
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